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Independent Living Resource Centre 
Adaptive Technology Program 

 
The ILRC is a resource centre designed by people with disabilities for 
people with disabilities. The resources, supports and opportunities found 
at the ILRC can help consumers stay in control of their lives. 
 
The ILRC also shares information and resources with other community 
organizations, students and teachers, government departments, 
agencies, businesses, and anyone who is interested in disability issues. 
 
Some services that the ILRC offers are: 
 

• Information & Networking 
• Individual Advocacy 
• Volunteer Services  
• Peer Support 
• Career Development 
• Adaptive Technology 
• CAP Site – Community Access Program 
• Research & Development 
• Independent Living Internship 

 
Adaptive Technology at the ILRC 
 
Adaptive Technology (AT) has become very popular at the ILRC. 
People who use it are able to overcome obstacles that would otherwise 
make it difficult for them to use a computer or access the Internet. 
 
The Adaptive Technology Program is funded through the provincial 
Department of Human Resources, Labour & Employment 
(www.hrle.gov.nl.ca/hrle/), with additional supports received through 
Industry Canada & Human Resource Social Development – Youth 
Employment Services. 
 
In the ILRC CAP (Community Access Program) site, we have a wide 
range of computer hardware and software all in a fully accessible 
environment. Anyone can come in and try out any piece of equipment to 
see what works best for them. Our AT Coordinator – Donna Greene – is 
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here to help people use the equipment and find ways to own it 
themselves. 
 
We currently have a whole bunch of exciting Adaptive Technology for 
you to check out. So if you are curious and want to learn more, feel free 
to stop by the ILRC for more information. 
 
Community Access Program – Innovation Fund 2008-09 
 
As part of our participation with the Community Access Program (CAP), 
in 2008-09 we were able to take advantage of new funding through the 
Innovation Fund. Thanks to this funding we were able to create quick-
start training manuals that help people learn specific Adaptive 
Technology software programs. The purpose of these manuals was to 
give people the necessary information to get them started with using the 
programs, and to do so in a way that was practical and easy to 
understand.  
 
We produced six manuals in total: 

- Dragon NaturallySpeaking v9.0 Preferred 
- Kurzweil 3000 
- WordQ/SpeakQ 
- JAWS 10 
- Key to Access 
- ZoomText v9.0 

 
Please note that these manuals are meant as an introduction to the 
program only. For further details about any of the information contained 
in these manuals, please consult the manufacturer’s user guides. 

 
 

Independent Living Resource Centre 
4 Escasoni Place 

St. John’s, NL A1A 3R6 
Ph: (709) 722-4031  |  Fax: (709) 722-0147 

TTY: (709) 722-7998  |  Toll Free: 1-866-722-4031 
Email: adaptech@ilrc-nl.ca   Website: www.ilrc-nl.ca 
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ZoomText 9.0 is a program that combines two pieces of adaptive 
technology: a Screen Magnifier and a Screen Reader. With the screen 
magnifier you can enlarge what you see on the screen up to 36 times its 
original size. With the screen reader you can have a narrator read 
what’s on the screen. These two tools allow you to see and hear 
everything on the screen and provide complete access to your 
documents, email, and the Internet. 
 
Note: ZoomText 9.0 is also available in a magnifier-only version; 
however, the material in this manual is based on the Magnifier/Reader 
version. 
 
This manual is meant as an introductory tool only. For more detail 
instructions on how to install and use ZoomText, please refer to the 
manufacturer’s user guide. You could also visit the manufacturer’s 
website (www.aisquared.com) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Introduction 
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You can start the ZoomText program in a couple of different ways.  

1. Double click on the ZoomText icon on your 
desktop. (The icon is a solid square with the 
letter Z in the middle.) 

2. Go to Start Menu, click Programs, and then 
click ZoomText 9.0.  

 
During the installation process, you have the option to tell ZoomText to 
start as soon as you turn on your computer. If you say ‘yes’ to this 
option, then you won’t have to complete either of the above steps. 
ZoomText will already be open. (For more information about installing 
ZoomText, please refer to Appendix A on page 15.) 
 
When the program is started, you will see the ZoomText 9.0 toolbar and 
a magnified view of your desktop. When the magnification level is higher 
than 1x, you may not be able to see your entire desktop. In order to 
move to “unseen” areas, simply move your mouse towards the edge of 
the screen. This will bring the rest of the area into view. 
 
The ZoomText toolbar holds all the controls you need to use ZoomText. 
You can choose things such as the level of magnification you need, 
what colors work best for you, and whether you want to use the narrator 
or not. 
 
There are three main things to point out on this toolbar: 
 

1. Across the top of the window is the Menu Bar - File, Actions, 
Magnifier, Reader, Settings and Help. 

2. On the far left of the window, you’ll see a big blue button with the 
letter Z in the middle. This button controls whether ZoomText is 
active or inactive. 

3. On the main part of the window are two tabs: Magnifier and 
Reader. (These are located to the right of the big blue Z button.) 
Each tab has its own set of buttons. 

 

Getting Started with ZoomText 
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The Magnifier tab lets you control the magnification power, the type of 
magnifier (whether it’s a window that follows your mouse like a 
magnifying glass, or your whole screen is magnified), the colors of your 
screen, the size and colors of your mouse pointer and text, and several 
other tools. 
 
The Reader tab lets you turn Speech on and off, control the rate at 
which it speaks, control Echo features (Echo will speak back the keys 
you type or your mouse clicks), and provides you with options for how 
ZoomText will read from different programs and documents. 
 
In the next two sections we will have a look at some of these features in 
more detail. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 5

 
The magnifier tab is made up of three sections – Zoom Windows, 
Enhancements and Finders. These options will allow you to control how 
ZoomText works for you. 

 
Zoom Windows: 

 
Power – Click on the arrows next to the power window to 
increase or decrease the level of magnification you want. You 
can go as high as 36X. 
 

Type – You have the option to only enlarge part of the screen 
rather than the whole screen. To set the type of magnification 
that works for you, click on the Type button. 
 

Enhancements: 
 

Color – If you want to change your screen colors to black and 
white or to use blue and yellow only, click on Color and you can 
change those settings. 
 
 
Pointer – If you want to change the size, shape or color of the 
mouse pointer, click on Pointer. 
 

Magnifier Options 
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Cursor – If you want to change the cursor so that it’s easier to 
find, click on cursor. 
 

 
Font – Click on Font if you want to change the way the words 
are displayed on your screen. You can make them darker or 
lighter, a different color, or a different style. 

 
 
Finders: 

 
Desktop – This allows you to find items on your desktop more 
easily. 
 
Web – This allows you to move to certain parts of a webpage 
without having to scroll (moving the page up and down 
manually). 
 
Text – If you are reading a text document, this will let you find 
specific words without having to go through the whole 
document manually. 
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The Reader tab is made up of three sections – Speech, Echo and 
Reading. The buttons on the Reader tab control how ZoomText reads 
things to you when you are using the narrator. 

 
Speech: 
 

Speech button – This is where you go if you want to turn the 
narrator on or off, and if you want to change the voice of the 
narrator. 

Rate – You can speed up or slow down the speech by clicking 
the arrows next to the rate window. 
 
 

 
Echo: 
 

Typing – This is where you can choose how much is read back 
to you when you are typing. For example, you can tell 
ZoomText to only read words instead of every letter in the 
word. 
Mouse – When you move your mouse pointer to a word, 
ZoomText will read that word out loud. This button lets you 
choose how this works. 
Verbosity (Verbos.) – This controls how much information 

Reader Options 
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ZoomText reads to you when you click on, for example, a 
desktop icon. At the Beginner level, ZoomText will provide 
more information. At the Expert level, it will provide less.  
 

Reading: 
 

Application Reader (AppRdr) – This feature reads text to you 
from the application you are currently using. For example, if you 
are checking email then this tool can be used to read a 
message you have just received. 
 
Document Reader (DocRdr) – This feature moves what you 
want to read to a new window where it is easier to read the text. 
 
Zones – This allows you to select different sections of a screen 
and “tag” them. When they’re tagged you will be able to move 
to them directly without having to go through the rest of the 
document. 
 
SpeakIt – This lets you read text from the screen by clicking 
and dragging the mouse over the text you want to read. 
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At the top of the ZoomText toolbar, you’ll see several menus (File, 
Actions, Magnifier, etc). Many of the same features we just looked at on 
the Magnifier and Reader tabs are also on the menu bar. But there are 
also some other controls you may be interested in. Let’s take a quick 
look at some of the menus that the toolbar provides. 
 
File Menu 
 
If you are not the only person who is using ZoomText on a particular 
computer, you may be interested in creating your own configuration 
file. A configuration file is a group of saved settings that tell ZoomText 
how you want it to work for you, such as what voice to use, the text color 
and mouse pointer size. When you set all the options you want to use, 
go to the File menu and click on Save Configuration. This will save your 
settings. (To open a configuration file, simply go to the File menu, select 
Open Configuration, and then choose your file.) 
 
When you are finished using ZoomText and want to close the program, 
simply go to the File menu and click on Exit. 
 
Actions 
 
Two important features on the Actions menu are: 

- Enable/Disable ZoomText  - turns magnification on and off 
- Enable/Disable Speech – turns the reader on and off 

 
Note that when you turn off the magnification, ZoomText is still active. 
The screen is just not enlarged. 
 
Magnifier 
 
The options under this menu are the same features that are on the 
Magnifier Tab (see page 5). 
 
 
 
 

The Toolbar Menu
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Reader 
 
The options under this menu are the same options that are on the 
Reader Tab (see page 7). 
 
Settings 
 
This menu contains a variety of specific program settings for fine-tuning 
how ZoomText works for you. Most of these features are beyond the 
scope of this manual; however, there is one setting that may be of 
importance. 
 
If you want ZoomText to start up automatically when you turn your 
computer on (and that option was not selected when the program was 
installed), you will need to go to the Settings menu then click on 
Program. You will see a blank checkbox next to “Start ZoomText 
automatically when the system starts”. To turn this feature ON, simple 
put a checkmark in the box. On the other hand, if this feature is already 
turned on but you want to turn it off, remove the checkmark. 
 
If you wish to learn about the other options on the Settings menu, 
please refer to the ZoomText user guide for specific information. 
 
Help 
 
The Help menu provides you with access to the information that is 
contained in the ZoomText User Guide without having to flip through 
pages in a book. The Help menu is divided into several sections to 
make it easier for you to find what you’re looking for. 
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The following section outlines some step by step instructions for using 
some of the more common functions of ZoomText. 
 
How To: Adjust the Magnification 
 
Perhaps the first thing you will want to adjust is the level of magnification 
you need. These quick steps will show you how to do that: 
 

1. From the ZoomText toolbar select the Magnifier tab. 
 

2. Under the Zoom Windows section is an adjustable scrollbar 
(up/down arrows to the right on the number) marked Power. Use 
the up and down arrows to increase or decrease the magnification 
to a size that you like. 

 
Try increasing the magnification power to 24x or 36x. If you get lost and 
can’t find the down arrow to go back to a smaller size, press Alt + Del on 
the keyboard. This disables ZoomText so you can reset the 
magnification. 
 
Tip! To increase the magnification quickly, press Alt + NumPad Plus on 
your keyboard. To decrease, press Alt + NumPad Minus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

How To’s 
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How To: Change the Zoom Display 
 
You may need to experiment with ZoomText’s many options before you 
decide on the settings that work best for you. The following exercise will 
help get you acquainted with how to choose different settings for zoom 
type, font, cursor and color. 
 

1. Make sure the Magnifier tab is open on the ZoomText toolbar. 
 

2. Set the power to 2.5x by clicking on the up and down arrows. 
 

3. Next click on Type. Choose Docked and then choose Bottom. 
 

4. Change your color by clicking on Color then Settings. Under the 
Color Enhancements section, select the Custom radio button 
(round dot). Under Custom Settings, set the Effect to Two-Color, 
Foreground Color to Dark Blue and Background Color to Yellow. 
Apply color enhancements to the Zoom window only. Click OK. 
 

5. Change the Pointer to the Giant Green scheme. (Click Pointer, 
clicks Scheme, and click Giant Green.) 
 

6. Change the Cursor to a custom setting that has a thick, red, solid 
circle. (Click on Cursor, then choose Settings. Under cursor 
enhancement, make sure the Custom radio button is selected. 
Under Custom Settings, select Circle for the type, Thick for the 
size, Red for the color and move the slider bar to the right to make 
the circle Solid. Click OK.) 
 

7. Change the Font by selecting Bold and Smooth. (Click Font, then 
Bold. Click Font again and make sure there is a checkmark next to 
Bold – this means the feature is turned on. Next click Smooth.) 

 
Your screen should now look like the image on the following page: 
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Do these colors and settings work for you? If not, repeat the steps and 
choose different options that work better! 
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How To: Use the Application Reader with Microsoft Word 
 
The Application Reader that comes with ZoomText is a convenient utility 
that will allow you to select an application on your computer (like MS 
Word) and have ZoomText read it from top to bottom. Here’s how: 
 

1. Open the MS Word file that you want to read. 
 
2. Go to your ZoomText Toolbar and open the Reader tab. 

 
3. Click AppRdr; your mouse cursor will change to show a 

small speech balloon next to it. 
 

4. With this new mouse cursor, click anywhere in the MS Word 
file you have open and ZoomText will begin reading. 

Note:  To pause and resume reading, simply use the Enter key on the 
keyboard. When you are finished with the AppRdr, press Esc on the 
keyboard. 
 
 
Tip! If you already working in MS Word and want to quickly access the 
AppRdr use the keyboard shortcut Alt+Shift+A. ZoomText will start to 
read your document. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To quickly move between ZoomText and 
other programs open on your desktop, 
press Alt+Tab on your keyboard. 
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How To: Change the Voice 
 
If you want to change the narrator’s voice, here are the steps to do it: 
 

1. On the ZoomText toolbar, open the Reader tab 
 

2. Click on the Speech button, and then Settings… 
 

3. The Speech window appears. 
 

4. Under the Synthesizer tab, you can change the voices 
using the dropdown box, and you can change the Rate, 
Pitch, and Volume using the arrow boxes under the 
dropdown menu. 

 
Experiment the different voices, speeds and other options to determine 
what you like best. 
 
 
 
 
How To: Use SpeakIt 
 
SpeakIt allows you to click any word on the screen and ZoomText will 
read it out loud to you. Here is how to use it: 
 

1. From the ZoomText Toolbar click the Reader tab 
2. Click the SpeakIt button located in Reading section.  
3. Your mouse cursor will change to show a small speech 

balloon next to the cursor; move your mouse over any word 
on screen and give it a left click. The word, no matter if it’s a 
desktop icon or text in a word file, will be read to you. 

 
To turn SpeakIt on using the keyboard, press Alt+Shift+I. To turn it off, 
press Esc. 
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Installing ZoomText 9.0 
 
Installing ZoomText 9.0 is a quick and easy process, you just need to 
make sure you have some minimum requirements before you install. 
You’ll need to have the following or better in your computer: 

 Windows 98 or newer 
 450 MHz Processor 
 512 MB RAM 
 25 Megabytes of free Hard Disk space 
 CD/DVD Drive 
 Sound Card/Speakers (for Magnifier Reader version only) 

 
Once you’ve confirmed that your computer meets the minimum 
requirements above, place your ZoomText CD into the CD/DVD Drive of 
your computer and follow the on screen instructions to install the 
software. 
 
If the Setup does not automatically start when you place the CD in the 
drive, follow these steps: 

1. Click on the Windows start button and select Run. 
2. Browse to your CD drive. 
3. Select the Setup program and click Open. 
4. Click the OK in the Run dialog box. 
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Activating ZoomText 9.0 
 
Activating ZoomText 9.0 is only necessary after its initial 30 days of use. 
In order to continue to use ZoomText 9.0 afterwards, you’ll need to 
activate using your serial number (included in the packaging with your 
copy of ZoomText 9.0). If you’re using an upgrade version as opposed 
to a brand new version, you’ll also need the serial number from your 
previous version. You can also find your serial number on the sleeve of 
the ZoomText 9.0 case, on the registration card, on top of the ZoomText 
9.0 box, or in the back of the user guide that came with your copy of 
ZoomText 9.0. Once you’ve got your serial number, you’ve several 
options for the actual activation procedure. 
 
Option 1: I have a serial and want to activate ZoomText 
If you have your serial number on hand, this will be the option you want 
to take. 
 
Option 2: I want to purchase ZoomText 
Choose this option if you’re currently using a demo of ZoomText 9.0 and 
wish to purchase a serial number. The wizard will then display 
information on how to purchase ZoomText 9.0. 
 
Option 3: I want to try ZoomText 
Choose the third option if you want to use ZoomText 9.0 in the 30-day 
trial mode. Trial mode allows you to use ZoomText 9.0 with all its 
features for the allotted 30 days. Once the trial is up you must activate 
ZoomText 9.0 to continue using it. 
 
 
 
 
 
 
 
 
 

Appendix B 
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Hotkeys 
 
User Interface Hotkeys 
  

Enable ZoomText 
 ALT + INS 
  
Disable ZoomText 
 ALT + DEL 

 
 
AppReader and DocReader Hotkeys (Magnifier/Reader only) 
 

Play/Pause Reading 
 ENTER 
  
Increase Magnification 
 ALT + NUMPAD PLUS 
  
Decrease Magnification 
 ALT + NUMPAD MINUS 
  
Increase Reading Rate 
 CTRL + NUMPAD PLUS 
  
Decrease Reading Rate 
 CTRL + NUMPAD MINUS 
 
Exit 
 ESC 
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Navigation Hotkeys 
  

Say Previous Word 
 LEFT 
  
Say Current Word 
 SPACEBAR 
  
Say Next Word 
 RIGHT 
  
Say Word Above 
 UP 
  
Say Word Below 
 DOWN 
  
Say Previous Sentence 
 CTRL + ALT + LEFT 
  
Say Next Sentence 
 CTRL + ALT + RIGHT 
  
Say Previous Paragraph 
 CTRL + UP  
  
Say Next Paragraph 
 CTRL + DOWN 
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Magnification Hotkeys 
 

Increase Magnification 
 ALT + NUMPAD PLUS 
  
Decrease Magnification 
 ALT + NUMPAD MINUS 
  
 Window Type 
 CTRL + SHIFT + Z 

  
 
Miscellaneous Hotkeys 
 

Capture ZoomText Screen 
 CTRL + ALT + SHIFT + C 
  
Cursor Detect 
 CTRL + ALT + SHIFT + D 

 
  
 
Reader Toolbar Hotkeys (Magnifier/Reader only) 
  

Speech On/Off 
 ALT + SHIFT + S 

 
 
Screen Reading Hotkeys (for screen reader only) 
 

Say Window Title 
 CTRL + ALT + W 
  
Say All 
 CTRL + ALT + A 
  
Say Selected Text 
 CTRL + ALT + S 
  
Say Current Time 
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 CTRL + ALT + I 
  
Say Current Date 
 CTRL + ALT + Y 

  
 
Scroll Hotkeys 
  

Scroll Up 
 ALT + UP 
  
Scroll Down 
 ALT + DOWN 
  
Scroll Left 
 ALT + LEFT 
  
Scroll Right 
 ALT + RIGHT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


